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An Archaeological LiDAR study and Walkover Survey at Bradgate Park, 

Newtown Linford, Leicestershire. 

Leicestershire. 

 

Nick Hannon, Andrew Hyam and Matthew Beamish 

Summary 

An archaeological LiDAR study and walkover survey was carried out by the University of Leicester 

Archaeological Services (ULAS) at Bradgate Park, Newtown Linford, Leicestershire. Analysis of the 

LiDAR data flown in January 2014 identified over 250 potential earthwork sites that are not within 

official records. These features and the known archaeological sites within the park were visited during 

a walkover survey undertaken between the 2nd and 9th of April. Features investigated included the 

deer park Pale, earthwork enclosures some of which appear to predate medieval features, undated 

terrace systems, multiple hollow ways or gullies, a possible village-type earthworks, moated sites, an 

18th Century racecourse and evidence suspected to stem from activity during the Second World War. 

Because of the non-intrusive method of investigation and recording many of the features are, as yet, 

undated. 

The archive will be deposited with Leicestershire Museums Service under Accession Number 

X.A63.2014 

Introduction 

This document forms the report for a LiDAR study and an archaeological walkover survey carried out 

at Bradgate Park, Newtown Linford, Leicestershire, NGR SK 532 108 (centre). The surveys are part of 

a larger scheme which intends to better understand the varied ecology and heritage of Bradgate Park 

designed to enable the park to enter into High Level Stewardship (HLS) with Natural England. This 

survey aims to identify and validate a range of potential archaeological features identified by a recent 

LiDAR survey along with those already existing on the HER. This work has accompanied the test pit 

evaluation of a known Late Upper Palaeolithic site within the park by ULAS which is reported 

separately (Cooper & Harvey 2014 ULAS Report 2014-090). 

The work has been commissioned by Cookson and Tickner on behalf of the Bradgate Park Trust. 

Background 

Bradgate Park lies approximately 4km to the north-west of the City of Leicester (Figure 1). Bradgate 

Park is currently used as a popular recreational park and attracts a wide range of visitors throughout the 

year. It forms one of the key leisure destinations for the population of Leicester as well as attracting 

visitors from beyond the county boundaries. 

The park covers an area of approximately 830 acres and has evidence of human activity extending as 

far back as the Upper Palaeolithic, with some material of Mesolithic date also found within the park. 

Records for prehistoric activity are otherwise absent from within the park, although there is some 

evidence for later prehistoric activity in areas surrounding the park, and some evidence of activity in 

the area in the Roman period. Bradgate Park was first enclosed to form a deer park in 1241 although 

the original boundaries have since evolved and changed to form the larger area now used as the park. 

During the medieval period the park formed part of the Manor of Groby and its larger estate. The well-

known Grey family owned the manor in the mid-15th century and it was this family who commenced 

building an unfortified brick-built house in 1499. The house ruins, which were subsequently modified 

and extended, form a centre-piece to the park as it exists today. After 1719 the park was no longer used 

as a residence and began to be used exclusively as a sporting estate. Remnants of a horse racing track 

around Old John still survive from this period (Figure 8). Access to the park by the general public only 
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began in 1928 when a local industrialist, Mr Charles Bennion, purchased the park. He then presented 

the park, in trust, to be managed for the benefit of the people of Leicestershire and visitors to the 

county. It is suspected that during the Second World War part of the park was used for military 

exercises and training which has further added to its significant place in the history of Leicestershire 

although the extent and duration of this activity appears little researched. 

 
Figure 1. Bradgate Park location 

Reproduced by permission of Ordnance Survey on behalf of The Controller of Her Majesty’s 

Stationery Office. Crown Copyright 1996. Licence Number AL 100029495 

The LiDAR study 

Introduction 

An aerial LiDAR scan was commissioned from the Environment Agency by ULAS on behalf of the 

Bradgate Park Trust. It was anticipated that this survey would enable the confirmation of known and 

suspected sites (other researchers have been active within the park cf. Hartley and Squires 

forthcoming), and to aid in the identification of previously unrecognised sites within the area of the 

park. The LiDAR was flown in January 2014 and supplied to ULAS in April 2014. Following swift and 

intensive processing and analysis of the LiDAR data the walkover survey was undertaken to investigate 

and record each known record, and potential new sites identified by the LiDAR survey (Figure 10). 
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Section 1 - Methodology 

Provision of LiDAR Data 

The LiDAR data was supplied by the Environment Agency electronically in ASCII file format and it 

consisted of two distinct types; HYBRID_DTM.asc and .las. Both of these file types covered the same 

geographic area and in the case of the HYBRID_DTM data had already been part-processed, gridded 

and geo-referenced by the EA. The HYBRID_DTM.asc data was a digital terrain model (DTM) and 

the .las a point cloud file. The DTM, which was supplied at a resolution of 0.5m provides elevation 

information of the earth's surface but has been processed by remove obstructions such as buildings and 

vegetation and provide a 'bare-earth' model. If the removal of obstructions left gaps in the surface data 

then these were left as “no data” areas. The .las file was the original point cloud data and not only 

contained elevation information but also contained various other readings obtained during the LiDAR 

flight including intensity data. This data had not been gridded into a raster format by the EA. 

For the purposes of this project the HYBRID_DTM data was processed for its elevation values, as this 

is the most informative from an archaeological perspective, and the .las was interrogated for its 

intensity data which can give indications on the quality of the reflective surface. 

 

LiDAR ASCII Data Processing 

Unless otherwise stated, all operations were conducted in Esri ArcMap10.1 SP1 build 3143. 

The EA provided a single HYBRID_DTM.asc file for the project area. This file was imported into 

ArcGIS using the ASCII to Raster function (System Toolboxes>Conversion Tools>To Raster>ASCII 

to Raster), the output data type was set to “Float” and the output raster filename was set to 

LiDAR_05m_2014. This file was placed in a newly created file geodatabase called “BP_Data.gdb”. 

The raster was already in a metre format so no further conversion was required. 

LiDAR LAS Data Processing 

The EA provided a single .las file for the project area. This file was imported into ArcGIS using the 

Create LAS Dataset function (System Toolboxes>Data Management Tools>LAS Dataset>Create LAS 

Dataset). The .las file was set as the input file and the output file name was set as 

LiDAR_05m_2014_LAS; all other settings left at default. This created a .lasd file in the ArcGIS folder 

within the User Documents folder. 

Following the creation of the LAS dataset a new layer is automatically added to the TOC (Table of 

Contents window). The next stage of the process was to right-click on the layer in the TOC and set the 

filters (Layer Properties>Filters) as a bare-earth model was required “Ground” was chosen from the 

predefined Settings. To confirm this change “OK” was pressed. 

Scheduled monuments were downloaded from English Heritage (www.english-

heritage.org.uk/professional/protection/process/spatial-data/): this data was received in shapefile format 

and was imported into “BP_Data.gdb” being called BP_Scheduled_Monument, this data covered an 

area greater than the survey area so was reduced to only contain information within the survey area 

using the clip function (Geoprocessing>Clip) using LiDAR_05m_2014 as the extent. The resultant 

shapefile was named Scheduled_Monument_Clip and saved to “BP_Data.gdb” 

Leicestershire County Council also provided a copy of HER in digital format via Cookson and Tickner. 

This was formed of three shapefiles, each name LeicsHER, one being a point file, one a line file and 

third a polygon file, these files were imported to “BP_Data.gdb”. Again the data covered an area 

greater than the survey area so was reduced to only contain information within the survey area using 

the clip function (Geoprocessing>Clip) using LiDAR_05m_2014 as the extent. The resultant shapefiles 

were named BP_LeicsHER_Clip and saved to “BP_Data.gdb”. 

Aerial Photography 

A high quality, vertical aerial photograph was supplied by Cookson and Tickner which covered the 

vast majority of the project area; this was imported in to the file geodatabase called “BP_Data.gdb” and 

added to the TOC, the original TIFF file was already geo-referenced so no further processing was 

required. 

http://www.english-heritage.org.uk/professional/protection/process/spatial-data/
http://www.english-heritage.org.uk/professional/protection/process/spatial-data/
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Digitisation of Newly Identified Features 

The project required the digitisation of any feature believed to be of archaeological interest, to facilitate 

this a polyline shapefile was created called “BP_LiDAR_Features”, this had its spatial reference set to 

British National Grid and saved in “BP_Data.gdb”. “BP_LiDAR_Features” was created with twelve 

additional fields (Table 1) 

Table 1: User defined fields on BP_LiDAR_Features 

Field Name Data Type Length Default Value 

Notes String 50 N/A 

Line_Feature_ID String 50 N/A 

X_Coord Float N/A N/A 

Y_Coord Float N/A N/A 

Start_X_Coord Float N/A N/A 

Start_Y_Coord Float N/A N/A 

End_X_Coord Float N/A N/A 

End_Y_Coord Float N/A N/A 

LiDAR_Domain String 50 N/A 

MONUID String 10 N/A 

Validated String 3 No 

Digitisation of newly identified features was achieved manually in a process detailed below. The Notes 

field was used to record a short description of the feature and was manually generated. The 

Line_Feature_ID was to record a unique ID for each identified feature, this was manually generated in 

an incremental fashion (e.g. FL00001, FL00002) as features were digitised.  

X_Coord and Y_Coord were used to record the coordinates of the features midpoint; once all features 

were digitised these fields were populated using the “Calculate Geometry” facility on the attribute 

table, with the property field set to X or Y Coordinate of Midpoint as required. The Start_X_Coord, 

Start_Y_Coord, End_X_Coord and End_Y_Coord fields were populated in a similar fashion using the 

appropriate property setting in “Calculate Geometry”. 

The LiDAR_Domain field was used to identify which LiDAR flight the feature appeared within, where 

a feature appeared in more than one LiDAR flight the date of the newer flight was taken. Once all 

features were digitised this field was populated using the “Select By Location” function 

(Selection>Select By Location), with selection method set to “select features from”, the Target layer 

set to “LiDAR_Features”, the Source layer set to each LiDAR flight individually using the outline 

shape files (e.g. LiDAR_1m_2011_Outline) previously created, working from the newest to oldest, and 

the Spatial selection method set to “have their centroid in the source layer feature”. This selected 

features which appeared within each LiDAR flight, the selected features than had the LiDAR_Domain 

field updated within the attribute table using the Field Calculator. 

The “MONUID” field was included to mirror a similar field in the local authorities HER, during 

project this field was not populated and was included to allow the local authority to add a HER number 

once any given feature has been designated. 

The “Validated” field was included to allow field observations to be recorded following the intended 

fieldwork which will commence once the LiDAR identification process is completed. During this 

project the field was left at its default value “NO”. 

Creation of Hillshade layers 

The main aim of the project was to identify archaeological features within the Bradgate Park study 

area. To aid feature identification, eight basic hillshade layers were generated for the LiDAR flight.  

Hillshades are a facility available in most GIS which allow an artificial sun to be shone from any 
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chosen compass bearing and from angle above the horizon onto a DEM. This process helps identify 

ground features by casting an artificial shadow behind changes in elevation, for a full discussion of the 

process see (Bewley et al 2005). 

Each of these layers were created using the hillshade function (System Toolboxes>Spatial Analyst 

Tools>Surface>Hillshade). The input raster for each hillshade was LiDAR_05m_2014. Three basic 

parameters were utilised to generate the eight different hillshade views, the setting for which can be 

seen in table 3. Azimuth relating to the compass bearing, Altitude relating to the angle from the horizon 

and Z factor relating to the degree of exaggeration applied to the input DEM, with 1 indicating no 

exaggeration. 

Table 2: Hillshade parameters for the four basic hillshades used 

Suffix Azimuth Altitude Z factor 

_HS_000_30_2 000 30 2 

_HS_045_30_2 45 30 2 

_HS_090_30_2 90 30 2 

_HS_135_30_2 135 30 2 

_HS_180_30_2 180 30 2 

_HS_225_30_2 225 30 2 

_HS_270_30_2 270 30 2 

_HS_315_30_2 315 30 2 

Each output raster was named to preserve the original input DEM information and include the hillshade 

parameters (e.g. LiDAR_05m_2014_HS_315_30_2) and saved to “BP_Data.gdb”. Once all eight 

hillshades were generated these were grouped within the TOC to aid navigation. 

Feature Identification 

Once the basic hillshade layers had been generated for each LiDAR flight, each OS 1km grid was 

systematically analysed for potential archaeological features, working from north to south and west to 

east. This was achieved cycling through each of the eight hillshade layers for each grid square 

individually. The shapefile layers containing both the HER and scheduled monument data were 

enabled to prevent re-identification of an already recorded archaeological feature. If a potential feature 

was identified this was then compared with both modern and historic OS information to see if a modern 

explanation could be established for each potential feature. If no modern explanation could be 

identified within the OS information then the area's aerial photography layer was viewed to see if this 

could help provide an explanation.  

If a potential feature could not be explained using the above methods then it was recorded as 

potentially archaeological, this was achieved by adding it to the “BP_LiDAR_Features” layer by 

tracing the features outline. A short description was added to the “Notes” field and a 

“Feature_Line_ID” assigned. This method was used until all areas covered by the LiDAR data were 

interrogated. 

Principal Component Analysis 

Deveraux et al (2007) have demonstrated that the use of Principle Component Analysis (PCA) can be 

an effective method of identifying subtle archaeological features within LiDAR data. This process 

effectively combines hillshade layers, providing one overall view which highlights features only visible 

as parts from different lighting angles.  Therefore following the principles detailed in their paper PCA 

were carried out for each of the focus areas.  

The PCA was created using the Principal Components function (System Toolboxes>Spatial Analyst 

Tools>Multivariate>Principal Components). The PCA layer was generated using the project area 

hillshade layers detailed above as the input rasters. The “Number of Principal components” parameter 

was set at eight to mirror the number of input rasters used and the “Output multiband raster” was 
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named to preserve the identity of the input raster and indicate which altitudes were being combined 

(e.g.. LiDAR_05m_2014_PCA_Altitude_30). 

Following the creation of the PCA layer, bands 1-3 were again interrogated and potential features 

recorded in the same manner as is detailed above for the initial feature identification process. Each 

PCA's band can be changed by altering the layers band setting (Layer 

Properties>Symbology>Stretched>Band) generally only band 1-3 are useful for archaeological feature 

identification, although the number of bands created is set by the “Number of Principal components” 

parameter detailed above. 

Sky-View Factor Analysis 

An alternate to the PCA process detailed above is the use of Sky-View Factor (SVF) (Zakšek et al 

2011). This method, instead of applying false shadows to a surface, calculates the volume of sky visible 

from a given position, a position at the bottom of a ditch affords a lower level of visibility to one atop a 

mound. This method produces a raster layer showing the volume of sky visible from each position 

within the raster which can highlight subtle archaeological features. SVF is not a function available in 

ArcMap, therefore a free to use version of the tool is available online (http://iaps.zrc-

sazu.si/index.php?q=en/svf). 

To utilise the tool the DEM for the project area was exported as a TIFF. This was achieved by right-

clicking on the DEM layer within the TOC (Data>Export Data) selecting a destination for the TIFF file 

and leaving all other parameters at default. Once the TIFF had been exported the SVF tool was run. 

The exported TIFF was used as the input DEM and Search Radius was left at the default 10. The 

Vertical exaggeration was set to either 1, 2 or 3 and Direction set to either 16 or 32, multiple Sky-

Views were run for each focus area using a range of values. The tool created an output TIFF file which 

reflected the name of the input DEM and settings used (e.g. LiDAR_05m_2014_SVF_d32_r10_ve3). 

This TIFF was then to imported into ArcMap and added to the TOC 

Following the creation of the SVF, these were again interrogated and potential features recorded in the 

same manner as is detailed above for the feature identification process. 

Area Solar Radiation 

A further method used to identify archaeological features within the focus areas was Area Solar 

Radiation (ASR). This method derives the volume of incoming solar radiation from an input raster 

surface and in a way similar to the previous two methods (Rich & Fu 2000). Although this method was 

not originally intended for archaeological research it can be an effective way of identifying subtle 

features. 

The ASR were created using the Area Solar Radiation Tool (System Toolboxes>Spatial Analyst 

Tools>Solar Radiation>Area Solar Radiation), the focus areas DEM was used as the input raster and 

output rasters named to reserve the identity of the input DEM (e.g. LiDAR_05m_2014_ASR), all user 

definable parameters were left at default. 

Following the creation of the ASR layer, this was again interrogated and potential features recorded in 

the same manner as is detailed above for the feature identification process. 

Creation of Intensity Raster 

The above methods all utilised the elevation data gathered during the LiDAR to identify potential 

archaeological features. An alternative method is to utilise the LiDAR intensity data, this records the 

amount of light returned to the LiDAR receiver from each pulse emitted and can help identify area of 

differential vegetation growth and thus has the potential to identify areas of sub-surface archaeology 

(see Challis et al 2011) 

The intensity raster was created using the LAS dataset to Raster function (System 

Toolboxes>Conversion Tools>To Raster>LAS Dataset to Raster). The input LAS dataset used was 

LiDAR_05m_2014_LAS.lasd, the output raster was named LiDAR_05m_2014_INT and saved in 

“BP_Data.gdb”. The Value Field was set to INTENSITY and Interpolation Type set to 

AVERAGE/NATURAL_NEIGHBOR. Output Data Type was set as FLOAT and Sampling Type set as 

CELLSIZE. The Sampling size was set to 0.4, this is essentially the resolution of the layer, this need to 

be about 20% less than the resolution of the gridded LiDAR data used to create the hillshades above. 

http://iaps.zrc-sazu.si/index.php?q=en/svf
http://iaps.zrc-sazu.si/index.php?q=en/svf
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Following the creation of the Intensity layer, this was again interrogated and potential features recorded 

in the same manner as is detailed above for the feature identification process. 

Digital Resource 

All files discussed above are available in digital format via a file geodatabase compatible with 

ArcGIS10.1. The database is: 

 BP_Data.gdb 

There is also a map file which contains the TOC in the format discussed above, this is named 

Bradgate_LiDAR.mxd:  this is compatible with ArcGIS10.1. 

Section 2 - Results 

Feature Type 

No formal classification scheme was adopted for the project: the possible identity or interpretation of 

potential features was recorded in the notes field of the LiDAR_Features shapefile. This is due to the 

difficulty in establishing the identity of the feature from LiDAR data alone and the need for first-hand 

validation (discussed below). However if the data is broken down into broad features types (Table 3) 

then it can be seen a large majority of the features are either banks or ditches. 

Table 3: Classification of features (excluding ridge and furrow and racecourse features) 

Feature Type Quantity 

Bank 166 

Ditch 117 

House Platform 18 

Mound 8 

Pit 35 

Track 4 

Total 348 

Feature Dating 

The assignment of dating to potential features through LiDAR data alone is notorious difficult and 

inaccurate, therefore during this phase of the project little attempt has been made to assign dates to any 

potential feature identified. However the assignment of broad time periods such as prehistoric or 

medieval has been applied in some cases and relative phases have been applied for examples where 

overlying phasing can be observed. 

Feature Location 

Potential archaeological features were identified throughout the Park, however their density became 

lower towards the parks centre (Figure 10). Notable areas of concentration were around the ruined 

house, around Old John Tower and Tyburn, although other smaller groups of features were also 

observed.  

Focus Areas 

Following the initial phase of feature identification, seven focus areas were chosen for further 

investigation. Greater time was taken to search these areas to aid fuller identification of the features 

within. A list of the focus areas and their locations and relevant character area can be seen in Figure 2 

and Table 4. 

Table 4: Details of the LiDAR focus areas 

Focus Area Character Area Location 

Old John High Park SK 525 112 

Bradgate House Garden Ruins Enclosure SK 534 102 

Tyburn High Park/Middle Park SK 524 105 

West of Hallgate Farm High Park SK 539 114 

Thorn Spinney Deer Sanctuary SK 533 098 

East of Bradgate House Low Park SK 537 104 
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West of Dale Spinney Middle Park SK 533 108 

Section 3 – Focus Areas 

Focus Area Introduction 

The following section contains a summary of the key features located within the focus areas detailed 

above. It provides examples of the types of evidence which can be gained through the use of LiDAR 

data. Each area is accompanied by a detailed illustration. 

 

 

Figure 2: Showing LiDAR results, character areas, and LiDAR focus areas. 

Thorn Spinney (Deer Sanctuary) 

On a small hilltop between Holly Plantation and Thorn Spinney lies a large ditched enclosure 

measuring c.140m by c.55m (Figure 3). The irregular form of the enclosure would be entirely 

consistent with a late prehistoric date although the wide south-facing entrance is uncommon. The 

eastern portion of this enclosure is overlain by the avenue of trees representing the parks early main 

entrance (MLE18596) showing the enclosure’s early origins. This enclosure had in part been observed 

during recent study of aerial photographs and field observations (Hartley & Squires forthcoming). 

Bradgate House Gardens 

Immediately to the east of the house ruins lies an area of formal garden. The LiDAR elevation data 

clearly details the 16th century parterres (Stevenson & Squires: 1999 30) which provide the garden its 

formal backbone (Figure 4). However analysis of the intensity data for this area has revealed a further 

pattern: concentric with the visible small circular area in the centre of the garden is a larger circle with 

what appears to be spokes radiating from the centre. This features has no topography and only appears 

as an intensity response, therefore it may be the shadow of an earlier design of formal garden long 

since forgotten. Geophysical survey is planned to provide further information on this feature. 
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East of Bradgate House 

To the east of the house ruins lies an areas of rough grassland (Figure 5). When the LiDAR data for this 

area is examined an area of disturbance became apparent. Running north-west to south-east there is 

what appears to be a Holloway (a path or track that has become sunken through use) which now runs in 

to the reservoir. A T-junction is also present with a branch running south-west towards the house's 

gardens. To the west of this branch appear a number of roughly square enclosures which may form 

house platforms. This area is overlain by the latter avenue of trees (MLE18595) running east from the 

house so is of earlier origin. This complex of features may represent a Deserted Medieval Village, 

possibly the lost village of Bradgate, previously believed to have been under Cropston Reservoir 

(Stevenson & Squires 1999: 14). Alternatively this may be the location of builders lodgings associated 

with the construction of the house. 

West of Hallgate Farm 

In the eastern area of the park, immediately west of Hallgate Farm is a complex of sinuous east-west 

ditches (Figure 6). These have in part previously been identified during field observations (Stevenson * 

Squires 1999 p72) but the full extent has now been revealed. A similar arrangement of previously 

unknown ditches can also be seen to the south of Coppice Plantation and these may well be associated. 

The function of these ditches is unknown, however no trace can be seen of the spoil removed during 

their cutting. Evidence of use of the park in the Second World War is starting to emerge, with the 

definite use of Bren Gun Carriers in June 1942, and it is possible that some earthworks result from 

activity at this time.  

West of Dale Spinney 

Towards the centre of the park are a number of circular pits measuring between 1m and 4m in diameter 

(Figure 7), the pits form four groups two clusters and two rows which appear to align to and post-date a 

long ditch and bank heading south-east from the site. The function of these features is unknown 

although suggestions have been made that they are prehistoric in origin (Hartley and Squires 

forthcoming) (see below p24). 

Old John Tower 

In the north of the park, in an area around Old John Tower the LiDAR analysis has revealed a complex 

field system radiating from the hilltop (Figure 8). This system comprises of a number of low banked 

boundaries and areas of terracing, in some places containing circular responses which may represent 

house platforms. This field system is related to an enclosure position to the north of the hill. This 

enclosure had previously been identified during field observations however the associated field 

boundaries had not been identified. The form of this field system suggests a prehistoric date. Encircling 

Old John, the route of an 18th Century racecourse has been identified. The route corresponds well with 

that shown on a 19th Century Estate Map (Ramsey 2011 p37). 

Tyburn 

Further south in the area between Tyburn and Elder Plantation lies a second area of field system 

(Figure 9). This area whilst almost adjoining the field system discussed above appear different in 

character, with more angular boundaries and a greater degree of terracing. The area at the centre of this 

system has been heavily disturbed by the fan of later land drains. The difference in form suggests a 

different phase from the more northerly system. The form of this system suggests a possible Iron Age 

date with similar examples being recorded a locations such as Skomer (Piggott 1981: 119 fig 21). 
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Figure 3: Earthwork enclosure between Holly Plantation and Thorn Spinney. (Hillshade 225302 with false colour) 
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Figure 4: Bradgate House Garden. Elevation data (above), Intensity data (below) revealing a possible circular feature signalled in 
the garden soils. 
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Figure 5: Possible evidence of medieval settlement to the east of Bradgate House 
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Figure 6: Ditch type features west of Hallgates Farm. (Hillshade 135/30/2 with false colour) 
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Figure 7: Area of Pit type features west of Dale Spinney. PCA Altitude 30. 
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Figure 8: Field systems, enclosures, and the line of the suspected 18th Century race-course around Old John (in yellow). 
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Figure 9: In the south-west of the Park: the Pale in the east, Field Systems, Enclosures, Ridge and Furrow, and later drainage 
features. Hillshade 000302 with False colour. 
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The Walkover Survey 

Objectives 

The objectives of this non-invasive survey were to provide current information on known 

archaeological remains within the park and investigate the features highlighted during the analysis of 

the LiDAR data. From this investigation and recording it is hoped that the results will provide 

information on the extent and nature of human activity within the area, and will allow informed 

decisions to be made on the future management of the site.  

Methodology 

Designated records (Scheduled Monuments and Listed Buildings) Historic Environment Records and 

newly identified LiDAR features were all incorporated within a relational database (Access 2010). Pro-

forma field recording sheets were prepared prior to the field survey. During the survey a significant 

number of additional features were identified and these are identified by the prefix W. As a guide to the 

location of each feature the annotated LiDAR survey converted from ESRI shapefile to Garmin IMG 

file and loaded onto a handheld GPS (Etrex 30) as custom backdrop mapping which was used 

throughout the walkover survey. 

Potential archaeological features were located using the handheld GPS and recorded using photographs 

and the pre-printed record sheets. This record included a grid reference of the feature centre point and, 

should the feature be very large, a grid reference of where the photograph was taken. In some cases the 

earthwork was so slight that a fabric strop was used in the photograph to aid in the visual identification 

of any changes in height. 

No invasive archaeological investigation was carried out as part of the walkover survey and 

archaeological recording. However, should any finds be discovered they would be bagged and labelled 

with their location and date and stored appropriately. 

For ease of description, the park was divided into nine similarly sized areas which were printed out as nine separate sheets at 

1:2500 on A3 starting with Area Sheet 1 in the south-western corner going up to Area Sheet 9 in the north-eastern corner (see 

Figure 10). This helped to group the features into manageable areas but in no way relates to any relationships which may or may 
not exist between them. 
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Results 

The walkover survey was carried out between the 2nd and 9th of April 2014. The weather varied from 

light mist to overcast with occasional sunny periods for most of the work. 

Table 5: Character Areas by Plan sheet 

Character Areas Plan Sheet 

Deer Meadow 2, 5 

Deer Sanctuary 1,2 

Hallgates 5,6,9 

High Park 4,5,7,8 

Little Matlock 1 

Low Park 2,5 

Middle Park 1,4,5,8,9 

Newtown Lawns 1,2,4,5 

River Valley 1,2 

Ruins Enclosure 2,5 

Area Sheet 1  

SW corner NGR SK 522 098 

NE corner NGR SK 530 102 

Area Sheet 1 covers the bottom south-west corner of the park which is characterised by the small rocky 

gorge through which the River Lin runs. The main tarmac road between the Newtown Linford and 

Hallgates car parks runs alongside the north bank of the river. To the south of the river is the deer  

sanctuary which is off-limits to the general public. 

The most prominent earthworks in this area are the park Pale (FL00612 – 615) (Figure 66) running 

from north to south and the mill leat (MLE18603) (Figure 46, Figure 47, Figure 48) running from the 

river across to Bradgate House. Both are very well-defined but have been cut through by later tracks in 

many places. This area also includes the internationally significant Late Upper Palaeolithic site 

(MLE9435) (Figure 31) which is also suffering from path erosion and has recently been evaluated by 

test pit (Cooper & Harvey 2014). Another area that has produced worked lithics was also visited, with 

some erosion also apparent (Figure 32). 

To the immediate east of the Pale, some 40m north of where Pale and Mill Leat intersect is a small 

rectangular ditched area (FL00019) (Figure 53) 

Area Sheet 2  

SW corner SK 530 095 

NE corner SK 540 102 

Area Sheet 2 incorporates most of the area surrounding the Bradgate House ruins and mill (MLE 745, 

746, 750, 14007, 14008) and the eastern half of the deer sanctuary including the Pheasantry.  

The house ruins, mill, stables, dog kennels, gatehouse, associated structures, gardens and pheasantry 

have not been assessed in any detail, but were visited during the walkover and an overall note on 

condition made (see Figure 25, Figure 26, Figure 27, Figure 29, Figure 33, Figure 34, Figure 37, Figure 

40, Figure 41, Figure 42, Figure 43). Other noteworthy features that are not designated or included in 

non-designated records include an irregularly shaped enclosure (FL00006) (Figure 49) which appeared 

to have been cut by later features associated with the house which might therefore suggest a relatively 

early date. A substantial moated site (FL00008/MLE739 Scheduled Monument 108813) (Figure 23, 

Figure 24) to the west of the house offers the potential of an earlier residence for the landowners, 

alternatively this has been identified as the parker’s house. A possible rectangular area inside the 

enclosure may indicate a building. To the north of this site is another rectangular enclosure (FL00016) 

(Figure 51). South-west of Holly Plantation, the LiDAR revealed a curving ditch which is visible on 

the ground as an area of marshy ground (Figure 54). A pair of rectangular depressions (W005) 

tentatively described as saw pits appear to be rather too large for a single saw pit, and may perhaps be a 

timber processing area or clay pit (Figure 72). 

To the north-east is an area of Water Meadow (MLE18601) (Figure 44). 
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Area Sheet 3 

SW corner SK 540 095 

NE corner SK 550 102 

Most of Area Sheet 3 is to the south and east of Cropston Reservoir and is beyond the limits of the 

park. A number of HER sites are in this area but are outside the scope of this survey. 

Area Sheet 4 

SW corner SK 521 102 

NE corner SK 530 110 

Area Sheet 4, in the western part of the park slopes up to the north and is centred on Elder Spinney. 

There are a number of higher rocky outcrops especially along the western side. Much of the bracken in 

the area has been rolled but there are still significant areas which are partially obscured. 

Of note in this area are a series of low banks or lips creating small terraces on a south-facing slope. 

This appears to be a deliberate creation of flat and open areas possibly for agricultural purposes (e.g. 

FL00490) (Figure 60) (FL00553) (Figure 62) (FL00554) (Figure 63) (FL00562) (Figure 64). A semi-

circular ditched enclosure (FL00018) (Figure 52) gives the impression of a possible prehistoric feature. 

This feature may connect with others (e.g. FL00483) (Figure 59) although the LiDAR patterning was 

not as convincing on the ground as the Hillshade plots suggest.  

The medieval Park Pale crosses the eastern side of this area curving slightly to the north (FL00639) 

(Figure 69). Modern, regularly spaced, drainage ditches run across the area as do a large number of 

small parallel ridges running across large parts of the area. The function of these ridges is not clear but 

their regular spacing and very straight lines suggest a relatively modern date. World War II activity is 

evidenced by  a bank of bare earth caused by chemicals leaching out of numerous bullets which can 

still be seen on the surface (this bare earth feature has been identified within the LiDAR data as is 

numbered FL00786). A number of possible slit trenches can be seen to the south of this bank (centred 

on SK5298 1051). In the north-eastern corner of the area are a series of worn hollow ways and possible 

tracks leading north-westwards. These undated features have not been identified on the LiDAR survey. 

Area Sheet 5 

SW corner SK 530 102 

NE corner SK 540 109 

Area Sheet 5 forms a broad shallow valley behind the Bradgate House ruins where the fish pond 

remains (Figure 28). The valley slopes up to the north towards Old John.  

To the east of Bradgate House gardens is an area of holloways and possible building platforms 

(FL00011-12 and MLE756) which may be the remnant of a Deserted Medieval Village (DMV) (Figure 

30). Close to this on the north-east side is a curious moated site (FL00009) (Figure 50) which appears 

to be too small to contain a structure and is very well-preserved. It is possible that it has an association 

with the nearby gardens. A chain of fish ponds lies to the east of the house (MLE18594) (Figure 38). 

More eroded tracks and hollow ways can be seen across the area, most noticeably joining those noted 

in Area Sheet 4 and another series in the north-east (FL00643 – 645). Again the origin and date of 

these features is not clear. Well-preserved banks and ditches run across the area. The 18th Century 

approach to the house was a tree lined avenue depicted by Kiddiar, (MLE18596) (Figure 39), with the 

Deer Barn to the north (Figure 45). A small enclosed area may be the location of a building represented 

in the foreground of Kniffe’s engraving  (FL00635) (Figure 68). A sinuous bank not specifically 

identified in the LiDAR survey runs from the north-east of the Ruins Enclosure toward Hallgates 

(W007) Figure 73). World War II activity can be seen as another bare bank (W008) with spent bullets 

in and a large number of what look like mortar or shell holes (FL00454 -481) (Figure 58). Many of 

these pit-like features intercut each other and have cut nearby banks and ditches. There is evidence of a 

possible bunker or trench at this point too. 

Area Sheet 6 

SW corner SK 540 102 

NE corner SK 550 110 
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As with Area Sheet 3, much of this area is covered by the reservoir and is therefore outside the park 

boundaries.  

Within the park there are a number of bank and ditch features and probable eroded tracks running into 

the park. Part of a group of immediately adjacent parallel features of unknown function can be found 

on the western side of the area (FL00647) (Figure 70). 

Area Sheet 7  

SW corner SK 521 107 

NE corner SK 530 116 

Area Sheet 7 is dominated by the two rocky outcrops on which sit Old John Tower (Figure 35) and the 

Leicestershire Yeomanry War Memorial (Figure 36).  

More potential terrace-like features (FL00502) can be seen on the southern slope leading up to Old 

John although these are not as clear or extensive as elsewhere in the park. A well-preserved ditched 

enclosure site with a possible entrance (FL00446-447) can be seen near to the Hunts Hill entrance 

(Figure 55), with another possibly associated feature parallel to the north (FL00655) (Figure 71). Some 

localised erosion is noted where a track crosses the west side of the enclosure (Figure 22). Further 

terraces are visible on the west side of Old John e.g. (FL00452) (Figure 57) and (FL00534) (Figure 61). 

As with many of the features identified by LiDAR there is no clear indication of a date for this. The 

remains of the 18th century race track (FL00778, 779, 780, 781) running around Old John can be seen 

in the form of large boundary stones either side of a flat track (especially clear between SK 52438 

11377 and SK 52363 11277) cutting the enclosure (FL00446/7) and another bank type feature 

(FL00619) (Figure 67).  Adjacent to Old John are the remains of stables (Figure 74). Within Old John 

Spinney a square area (FL00451) is defined in the LiDAR, visible as clearly defined negative feature 

on the ground (Figure 56). 

Area Sheet 8 

SW corner SK 530 110 

NE corner SK 540 114 

Area Sheet 8 forms a wide sloping east to west valley which narrows down to a funnel at its east end 

near to Hallgates. Along its north end are a series of sinuous ditches (FL00593 – 598) winding up the 

slope towards the west (Figure 65). Similar, but not quite so deep, features can be seen on the southern 

side of the valley with may suggest eroded tracks rather than deliberate earthworks. The ditches almost 

appear to be respecting the stone walls although this may be simply preferential preservation. These 

features have been tentatively identified as prehistoric (Hartley and Squires forthcoming) although a 

modern military origin may in fact be their origin. Alternatively, there may be re-use of existing 

landscape features. 

Area Sheet 9 

SW corner SK 540 110 

NE corner SK 550 116 

Area Sheet 9 covers the north-east corner of the park around the Hall Gates car park. Much of this area 

has evidence of ridge and furrow which seem to respect a quarried outcrop of rock. Some banks and 

ditches can be seen beneath the ridge and furrow and these must be pre-medieval. 
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Figure 10: All features also showing location of sheets 1-9, with Hillshaded LiDAR data (false colour). LiDAR source: Environment Agency 2014 
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Figure 11 Area Sheet 1 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 



Bradgate Park LiDAR study and Walkover Survey 

ULAS Report No.2014-076 Accession No X.A63.2014  28 

 
Figure 12 Area Sheet 2 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 13 Area Sheet 3 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 14 Area Sheet 4 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 15 Area Sheet 5 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 16 Area Sheet 6 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 17 Area Sheet 7 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Figure 18 Area Sheet 8 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 



Bradgate Park LiDAR study and Walkover Survey 

ULAS Report No.2014-076 Accession No X.A63.2014  35 

 
Figure 19 Area Sheet 9 with LiDAR interpretation. LiDAR source: Environment Agency 2014. 
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Summary of Results 

391 records are included in the Archaeological Assessment. These include 2 Scheduled Monuments, 5 

Listed Buildings, 34 Leicestershire Historic Environment Records and 342 records resulting from 

analysis of the LiDAR data.  

Significance of Assets is judged using criteria as set out in the Design Manual for Roads and Bridges 

(DMRB HA208/07, Annexes 5-7). 

Table 6: No of Records per Character Area. Some records cross a number of character areas. 

Character Area No of records 

Deer Meadow  4 

Deer Sanctuary 18 

Hallgates 23 

High Park 158 

Little Matlock  7 

Low Park 21 

Middle Park 138 

Newtown Law ns 25 

River Valley 7 

Ruins Enclosure 15 
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Figure 20: Character Areas 

Deer Meadow 

This is an area of Water Meadow (MLE18601) of Medium to High Significance on the basis of the 

rarity of water meadow survival. The eastern avenue of trees that marked one of the approaches to the 

house crosses the north-east of the area (MLE18595) 

Deer Sanctuary 

The southern approach to the house crosses the Deer Sanctuary (MLE18596). Few trees survive 

although side ditches are visible. An area of suspected gatehouse is visible in the north of the area. Part 

of the medieval Park Pale can be traced in this area, and is well preserved in places. An unknown 

enclosure of irregular shape 150m by 55m with entrance in the south has been identified running 

between Holly Plantation and Thorn Spinney. The ditch of this feature clearly survives as an 

earthwork; although this suggests the feature is perhaps medieval, the broad form would be consistent 

with a later prehistoric form and this would be of high significance. Nine further possible ditches have 

been identified in the LiDAR data in this area of which six have been identified on the ground. These 

features are undated and are of unknown significance.  

This area contains medieval ridge and furrow earthworks at the western end which is of low 

significance but of interest in its relationship with the emparked area. The bank of another possible 

enclosure some 80m across has been identified 100m north of the park southern boundary.  
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Hallgates 

Finds of Roman pottery and a coin have been made in this area. As isolated finds they are of low 

significance and should not be over-interpreted. It should also be noted that finds of Roman tile were 

recently made from the Lin in the Little Matlock gorge area (Dr Phil Mills pers comm.).  

Areas of ridge and furrow cultivation can be traced in the north of the area, and these are bounded in 

the south by the line of the medieval Pale (FL00592). There may be two phase of Pale apparent on the 

eastern edge, with the lines diverging just to the east of the modern track with one line turning abruptly 

to the south. 

Traces of a possible earthwork bank have been identified below the ridge and furrow (FL00572) and 

would be of high significance if of pre-medieval date. Traces of a curving bank and ditch have been 

identified within the Coppice Plantation which may be part of, or predate the medieval field system 

part of which lies to the east. 

High Park 

Dominated by Old John and the War Memorial to the Leicester Yeomanry other statutory records 

include the site of a post mill. Although no direct evidence of the post mill has been observed, this 

location also includes the remains of a small stable cut into the rock outcrop which is extant.  

To the east, west, south west and north of Old John are series of banks and ditches that divide up the 

area into smaller blocks. On the basis of their form and that they do not clearly belong to later periods, 

it is suggested (Hartley & Squires forthcoming) that these are evidence of late Prehistoric or Romano-

British field systems. Detailed study of the LiDAR data has led to the identification of possible 

platforms within terraces on the eastern side of Old John, and these may potentially be house platforms 

contemporary with the suggested field systems.  To the north of Old John, a sub-square enclosure some 

40m across survives. This appears to predate the racecourse (below) and could be of prehistoric or 

possibly medieval origin. If the interpretation of any of these remains as pre-medieval in date is correct, 

these features would be of high significance as they are regionally extremely rare as earthwork 

remains. 

Evidence of a possible new phase of medieval enclosure has been identified in the LiDAR data 

between Sliding Stone enclosure and Dale Spinney. A north–south bank is abutted by a Park Pale 

boundary, and would appear to predate the Park Pale although this may be illusory. This feature can be 

traced north for over 500m . Detailed field observation is required to validate this observation before 

any interpretations can be confidently drawn.  

Two probable Pillow mounds (Rabbit Warrens) of late Medieval or Early Post Medieval date can be 

identified in the extreme south-west of the area. The adjacent road is named Warren Hills.  

The course of an 18th Century race track which encircled Old John can be traced with some confidence 

in the LiDAR data as the boundary stones which marked each side of the track can be identified on 

western and northern sides (Ramsey 2011). Within Old John Spinney, the remains of a square 

enclosure some 40mx40m are evidence of some previous structure. 

In the extreme east of the area, a series of sharply incised sinuous ditches are visible just within the 

park’s boundary. It has been suggested (Hartley & Squires forthcoming) that these may have a 

prehistoric origin but this is considered most unlikely. That they have resulted from wartime activity 

(which is now starting to emerge within the Park’s recent history) is considered much more likely.  

Middle Park 

The Middle Park contains the majority of the northern area of the medieval deer park. The exact line of 

the Pale can be traced with accuracy from the LiDAR data, and the high degree of accuracy afforded by 

the LiDAR evidence shows some deviation from the recorded line.  

Ridge and Furrow can be found in the extreme west of the area.  

Further traces of terraces that are possible relict field systems can be identified to the south and to the 

east of Tyburn. Drainage features can be strongly identified in herringbone type configuration between 

Tyburn and Elder Plantation, and these are of 19th or 20th Century date. South of Elder Plantation, a 

sharply defined curving ditch may form the south-western part of a possible enclosure of around 1ha 

which is bisected by the medieval Pale. As this ditch is medieval or earlier, it is of medium or higher 

significance.  
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Between Bowling Green Spinney and Dale Spinney ditches and banks marking linear features crossing 

south-west to north-east may stem from medieval holloways crossing this area on the east side of the 

stream which is flowing down toward the fishpond area.  

In places, the features appear in parallel lines, and this has led to an interpretation that a Bronze Age 

triple ditch boundary may survive in this area. Although this remains possible, the likelihood is that 

these remains relate to later occupation and they may be associated with the area of medieval 

settlement identified to the east of Bradgate House. 

Evidence of a possible new phase of medieval park enclosure has been identified in the LiDAR data 

between Sliding Stone enclosure and Dale Spinney. A north –south bank is abutted by the known Park 

Pale boundary, and would appear to predate the Park Pale although this may be illusory due to 

truncation of the Pale to the east. This feature extends into the High Park and can be traced north for 

over 500m before it disappears where reservoir works start. 

The Park Pale cannot be clearly traced to the east of this north-south feature although it can possibly be 

identified on the south-eastern edge of Dale Spinney and it is likely that rocky outcrop formed much of 

the park’s boundary in this area. 

To the south of the intersection of the known Pale and the newly identified north-south feature, 30 pits 

have been identified within an area 60mx70m. The features which vary between 1.5 and 3m in 

diameter, are arranged in both clusters, and lines. Some appear to be intercutting, although most are 

discrete. It has been suggested that these features stem from a prehistoric pit alignment boundary and if 

this were to be the case, these would be of high significance for the survival of earthworks of this date 

(Hartley & Squires forthcoming). Although this remains an outside possibility, the features are 

immediately adjacent to an area of bare soil bank which contains visible ammunition/bullets. It is 

suggested that these features survive WWII training activity which is now being identified as part of 

the Park’s history, as a training area and for the staging of a mock battle in 1942 (Leicester Mercury 

Supplement 1984). 

A small rectangular mark associated with a possible track to the south of Dale Spinney may relate to 

the building showing in the foreground of the Knyffe illustration (1700).  

In the south-east of the area, a series of parallel and sinuous ditch features have been identified. These 

appear superficially similar to those identified in the north-east of the High Park and may well have a 

similar military origin. 

The Low Park 

This area contains the continuation of the suggested north-west south-east trackway suspected to be of 

medieval date. To the south of Deer Park Spinney, and second trackway leaves at a right angle heading 

toward the south-eastern corner of the Ruins Enclosure. A series of rectangular parcels of land have 

been identified to the north of this trackway, and it is suggested that these may be the remains of 

medieval settlement. 

To the north of this group is a strongly defined 14m square ditched enclosure. It is of unknown purpose 

and date, although it is assumed that it is contemporary with a phase of occupation of the house. 

Newtown Lawns 

This area contains an area of Late Upper Palaeolithic open occupation which is of High to Very High 

Significance, as this type and date of site is internationally rare. 

A moated site (scheduled monument 108813) some 176m to the west of the house ruins has been 

sharply defined from the LiDAR data with some further detail on earthworks on the south-western side, 

and a suggestion of a building within the enclosure. This site is historically interpreted as a keeper’s 

lodge. 75m to the north is a second rectangular enclosure of similar size to the moated site has been 

identified. This appears to be associated with a series of linear features which may be acting as water 

supplies to the moated site to the south. 

The dog kennels MLE18598 to the south of the house ruins are in the east of the area. This area 

currently is disturbed ground with possible foundation stone visible due to some erosion. 

Part of the area of stables that served the house fall within this area, and are visible as a ditch with 

some brickwork in places. 
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Other features include possible building footprints, and linear ditches in the east of the area. 

River Valley 

This area contains the Pheasantry, the Stables to the south of the house. It is crossed by the medieval 

park Pale.  

The alluvial nature of this area will have resulted in the preservation of archaeological and 

environmental material within flood silt deposits from all periods. 

Ruins Enclosure 

This area includes the Scheduled remains of the House, Chapel and Mill, the Gardens, Tiltyard and 

Fishponds and Leat. 

Analysis of the LiDAR intensity data for the site has revealed a circular feature within the walled 

garden. This may stem from a late medieval garden design and is of high archaeological significance. 

Little Matlock 

This area contains medieval ridge and furrow earthworks at the western end. Two bank of a possible 

enclosure of a rectangular enclosure have been identified but are not verified. 

Pieces of Roman tile have recently been found in the bed of the Lin to the west of the Pheasantry (Dr. 

Phil Mills pers comm.) 

Significance 

The historic emparking of the area and the consequence of extremely limited cultivation of much of the 

area has resulted in a landscape which retains a rich archaeological earthwork record providing 

evidence of earlier park and pre-park uses. 

The most important site within the study area is the Late Upper Palaeolithic Site to the west of Newton 

Lawns (Figure 21, A), which has been confirmed through recent survey to be of international 

importance as a very rare discovery of an open air Creswellian flint-working site. This site, identified 

through chance discovery is associated with the Little Matlock Gorge which offered a rare topography 

which was attractive to hunters. Other hunting sites might be expected near to the Gorge either 

associated with rocky outcrops or sealed along with contemporary palaeoenvironmental deposits below 

alluvial sediments adjacent to the Lin (Cooper & Harvey 2014) . It is emphasised that the discovery of 

the known site was effectively by chance and not the result of any systematic work. A fuller picture of 

the extent of these deposits could be achieved by structured archaeological and palaeoenvironmental 

survey. 

Within extensive earthworks revealed across the park are newly identified banked and ditched 

enclosures (Figure 21, B & C), and possible terrace field systems which may stem from the later 

prehistoric periods (Figure 21, D & E). It is not possible to date these features without intrusive 

investigation, but should they be of prehistoric date, they would be of a high significance due to their 

rarity. Survival of pre-medieval field systems as earthwork features is rare nationally and would be 

exceptional regionally and these features would be very important assets within the park. In the north-

east of the park in the Hallgates area are a series of deeply incised parallel ditches (Figure 21, K). A 

clear understanding of the dating of these substantial features is important in assisting their 

interpretation and future management. 

Other earthworks that have a clearer medieval character are stretches of the medieval park Pale and the 

Scheduled moated house site (Figure 21 , H) (which is by definition of national significance). Evidence 

of possible medieval occupation (Figure 21, G) to the east of the house ruins (Figure 21, J) is a 

significant discovery and with confirmation through further survey would extend the archaeological 

narrative for the development of Bradgate House. Later adaptation and use of the park through the 

Tudor era and beyond is also reflected in the archaeological record, with features including the possible 

sites of outbuildings and structures relating to the Tudor park. Further work is needed to refine our 

understanding of the structural remains in the vicinity of the house that stem from this period as there is 

probably a greater complexity to the surviving remains than can be interpreted from the documentary 
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evidence which is the source for the known building records in this area. Features relating to the 

estate’s later 18th and 19th century use including the 18th century racetrack and the former stables 

below Old John. Evidence of a structure and enclosed area within the Old John Spinney may relate to 

this phase. Taken as a whole, the archaeology providing evidence of the development of the medieval 

and later phases of the park may be considered to be of national significance for their collective value.  

The park also contains the distinctive remains of Bradgate House (Figure 21, C), built in brick as an 

early example of a non-defensive house c. 1500 by the 1st Marquess of Dorset. The house was 

abandoned in 1739 and gradually reduced to the romantic ruin, which remains today. The site of the 

house and immediate garden is a Scheduled Monument, whilst the park as a whole is included at grade 

II on English Heritage’s Register of Parks and Gardens of Special Historic Interest, making them both 

of national importance. The archaeology of the gardens and immediate park remains legible with 

associated features such as fishponds also surviving, and the interest of these remains in reflecting an 

abandoned Tudor garden is such that it likely warrants extension of the Schedule designation to cover 

its entirety. New information contained in the LiDAR intensity data indicates that new facets of garden 

design may be revealed through the application of new methods and technologies. Earthworks to the 

west of the house including at least one moated site within which evidence of a building is emerging 

alongwith other enclosures and probable water bearing ditches add to the temporal and spatial 

complexity.  

Old John Tower to the north, marking the site of a previous windmill within the park, and the adjacent 

Yeomanry War Memorial are both Grade II Listed buildings and of national significance. 

A significant 20th century archaeological layer has been uncovered through recent survey which 

supported by some newspaper and photographic evidence has identified areas of possible WWII 

activity that has left its own archaeological signature which has consequently clouded some of the 

understanding of previous phases. These features are nevertheless of local significance, or possible 

regional collective significance in reflecting concerted wartime use. It is quite possible that pre-existing 

features were used in the modern military phase, and apparent second world war features do in fact 

have a much earlier origin.  

 

Figure 21: Key sites as centre points 

 LiDAR Source: Environment Agency 2014  

 

 

Comment [mgb31]: From RC: Do the 

garden remains need the protection offered 
by scheduling or can they be addressed 

through strengthening understanding of the 

remains, inclusion in the management plan, 
and/or reconsideration of the HPG 

registration? 

 

Comment [mgb32]: MGB requested 
info from WC. 
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Table 7: Key sites 

Key Name 

A Creswellian Site 

B Enclosure in Deer Sanctuary 

C Enclosure to north of Old John 

D Field Systems below Old John 

E Field Systems below Tyburn 

F Medieval Park Pale / Pit area 

G Earthworks to east of Bradgate House 

H Moated Site 

J Bradgate House and associated structures 

K Ditches in Hallgates area 

Erosion 

Ongoing erosion of monuments was not widespread across the Park features.  

Designated sites: Specific erosion problems were noted for the known Creswellian Upper Palaeolithic 

site (MLE9435) (which has been the subject of evaluative work reported separately) and also for 

another area where worked lithics have been recovered which have been dated to the Mesolithic 

(MLE9436). 

The Mill Leat (MLE18603) is suffering ongoing erosion especially around NGR SK5287 1015, and 

there is also damage being caused to the Dog Kennels (MLE18598) where possible foundation stone is 

being exposed.  

Near to the reported finding of a Roman coin (MLE21007), a footpath is exposing bare-earth. 

Erosion has recently (May 2014) been noted on the west side of the newly identified enclosure to the 

north of Old John (FL00447) where several paths converge. This earthwork is currently undated but 

may be of later prehistoric date and measures to prevent further erosion of these features should be 

considered. 
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Figure 22: Path erosion across ditch and bank of undated enclosure (FL00447)  to the north of Old John 

 

The main threat to archaeology within the park is from localised erosion, due to visitor pressures in 

areas of high footfall and from deer in other localised areas. Evaluative test pitting of the Late Upper 

Palaeolithic site has provided information to enable an understanding of the site’s condition, character 

and associated significance and, based on that, to inform management decisions regarding its future 

treatment. A number of earthwork features are also suffering from erosion, including stretches of 

medieval park Pale and the leat through Newtown Lawns. 
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Table 8: Erosion areas noted during walkover survey and subsequently 

PRN Description Visit Date Character Area Easting Northing Comment 

FL00534 Bank in Bradgate 

Park 

09-Apr-14 High Park 452210.00 310963.00 Vehicle damage on a current track. 

FL00535 Bank in Bradgate 

Park 

09-Apr-14 High Park 452308.00 310928.00 Vehicle damage on a current track. 

FL00614 Park Pale Bradgate 

Park to south of 

Mill Leat in West. 

09-Apr-14 Newtown Lawns 452881.00 310110.00 There is a boggy area where the Mill Leat, and Medieval Pale intersect, and 

both Pale and Leat are suffering ongoing erosion. There is a Vehicle track 

running south-north through gap in wall, and several human/deer tracks 

running west-east on the north side of the wall.  

FL00617 House Platform in 

Bradgate Park 

08-Apr-14 High Park 452666.00 311082.00 There is evidence of erosion in the past, but this is now grassed over, and 

not a management problem. 

FL00635 Enclosure in 

Bradgate Park 

04-Apr-14 Middle Park 453638.00 310653.00 Vehicle damage on a current track. 

MLE18598 Dog kennels south 

of Bradgate House; 

KENNELS 

02-Apr-14 Newtown Lawns 453429.22 310120.09 The modern roadway crosses on the southern side of the Kennels area.  

MLE9435 Creswellian site at 

Bradgate Park; 

SITE: 

02-Apr-14 Newtown Lawns 452609.88 310069.34 Footpath is causing erosion especially through area of rocky outcrop. 

MLE18603 Leat from the Lin to 

Bradgate House; 

LEAT, DAM 

02-Apr-14 Little Matlock, 

Newtown Lawns, 

Ruins Enclosure 

453002.84 310312.41 There is a boggy area where the Mill Leat, and Medieval Pale intersect, and 

both Pale and Leat are suffering ongoing erosion. There is a Vehicle track 

running south-north through gap in wall, and several human/deer tracks 

running west-east on the north side of the wall.  

MLE9436 Mesolithic flints 

from Bradgate 

Park; SITE 

02-Apr-14 Little Matlock 452406.88 310039.41 Pedestrian traffic erosion 

MLE21007 Roman coin from 

near Hallgates 

entrance to 

Bradgate Park; 

FINDSPOT 

05-Apr-14 Hallgates 454200.00 311200.00 Vehicle damage on a current track. 

FL00447 Earthwork 

enclosure 

18-May-

14 

High Park 452540 311482 Footpaths are causing erosion of earthwork banks (Figure 22). 
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Discussion 

The LiDAR survey has succeeded in identifying a large number of earthwork features, some of which 

were known from previous studies but many of which are new. Many of the earthworks are clearly 

associated with the park boundaries, i.e. the park Pale, and are presumed to be of medieval date. 

However, others, such as a series of probable terrace systems seen in the western and northern parts of 

the park are harder to date although would appear to be of pre-medieval date. 

The preservation of pre-medieval field systems as earthwork features in Leicestershire is extremely rare 

and the two clear areas of identified system in the vicinity of Old John, and Tyburn, the former with a 

possibly associated enclosure, both require a more detailed understanding for their significance to the 

Park and the wider area to be better understood. If these features were to be proved to be of prehistoric 

or perhaps Romano-British date they would be highly significant and would attain great importance 

within the park.  

The possible evidence of medieval occupation to the east of Bradgate House appears to be quite 

extensive and if the date and character of these remains can be demonstrated would greatly expand the 

understanding of the development of the park in the medieval period prior to the construction of 

Bradgate House. The moated site and the other earthwork and structural remains in its vicinity also 

form part of this picture. The curious small moated feature on the north-west side of Bradgate House 

may be part of the house garden complex.  

Surviving ridge and furrow near to the Hall Gates entrance shows the agricultural uses of the park area 

outside the original hunting park boundaries. The multiple parallel ridges seen in the north-western part 

of the park appear to be quite late as they cut most other features. Their origin is not, as yet, clear but 

might be associated with drainage or ground management.  

The large numbers of multiple hollow ways seen most especially towards the north-east areas of the 

park are difficult to date. Those given LiDAR numbers (FL00593-598) are the most well-defined with 

fairly crisp edges and could give the impression of being deliberately dug. They could therefore be 

boundary ditches as suggested by Squires (Stevenson and Squires 1999 p72). They could also be track 

ways possibly associated with the Broad Gate route. However, similar, less deep, features can be seen 

nearby which could be interpreted as eroded tracks. Are FL00593-598 simply deeper tracks with the 

same origin? It is known that that parts the park was used for military training during the Second World 

War which included the use of tracked vehicles capable of causing widespread erosion. A series of 

Bren Gun carriers from the 48th  Division are pictured in mock action and also giving rides to an 

audience of munitions workers and general public who were witnessing war-gaming in June 1942 

(Leicester Mercury 1984). Anecdotal evidence also suggests that motorcycle despatch rider training 

also took place there which might easily create a number of single meandering gullies of the type seen 

here.  

Second World War activity is clearly seen in the two shooting butts areas where the large number of 

spent bullets eroding out of a bank continues to kill the vegetation. Investigation of the possible 

trenches and bunker may yield further information about this area. The potential mortar and shell 

craters attest to an interesting period in the history of the park. Should any future work be carried out 

here it should be borne in mind that there is the potential for unexploded ordnance.   

During the survey a number of additional features were noted and others pointed out by Rob Clough. 

These would warrant further inspection of the LiDAR results and further inspection and interpretation 

on the ground.   

This archaeological study which has combined the generation, analysis and interpretation of LiDAR 

data evidence along with a walkover survey has enabled the identification and interpretation of 

numerous possible new sites, and this has thrown an objective light upon the known archaeological 

record of the park which can be used to validate all previous assumptions of the park’s development. 

This can include for example the phasing and development of the park Pale, features which may be 

prehistoric or in fact relate to WWII activity, or the preserved circuit and boundary markers of the 18th 

Century racecourse.  

A number of discoveries have posed more questions than have been answered. Some opportunity to 

address some of these questions may be provided through the University of Leicester’s planned field 
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school in the coming years although other mechanisms enabling the investigation of targeted 

archaeological deposits will need to be found to answer all the questions raised. Although professional 

expertise would be essential in the direction, interpretation and analysis of results, community 

archaeology groups (e.g. the recently formed Groby Group and the current Charnwood Roots project) 

offer potential for the engagement of people from a variety of sectors in this work and for a variety of 

models to be used in response to the archaeological issues identified. 

 

The recent identification of earthwork features in the park prior to the LiDAR survey (Hartley and 

Squires forthcoming) was made possible by the bracken rolling programme which was expanded in the 

spring of 2012. Continued bracken management across the park is required to maintain the visibility of 

the earthworks both for interpretation and for further study. Some of these terraced areas are still 

partially obscured by bracken and further survey with continuing management of the bracken would 

yield results. 

Publication 

A summary of the work will be submitted for publication in the Transactions of the Leicestershire 

Archaeological and Historical Society in due course. A record of the project will also be submitted to 

the OASIS project. OASIS is an online index to archaeological grey literature. 
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Appendix 1:  Walkover survey photos: 

 
Figure 23: MLE739 moated site (lodge?) Photo 3838 Looking NE 

 
Figure 24: MLE 739 moated site (lodge?) Photo 3912 Looking N 
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Figure 25: MLE745 Bradgate House ruins Photo 3848 Looking NW 

 

 
Figure 26: MLE745 ruins plus MLE746 chapel (on left)  Photo 3849 Looking NE 
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Figure 27: MLE746 chapel Photo 3851 Looking SW 

 

 
Figure 28: MLE747 fishpond Photo 3862 Looking E 

 



 

ULAS Report No.2014-076 Accession No X.A63.2014  51 

 
Figure 29: MLE750 mill Photo 3970 Looking N 

 

 
Figure 30: MLE756 possible remains of medieval settlement Photo 3901 Looking NW 
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Figure 31 :MLE9435 Late Upper Palaeolithic site Photo 3824 Looking NE 

 

 
Figure 32: MLE9436 Mesolithic flint findspot Photo 3826 Looking SE 
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Figure 33: MLE14007 Garden wall Photo 3856 Looking SE 

 

 
Figure 34: MLE14008 Tiltyard  Photo 3853 Looking SE 
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Figure 35: MLE14009 Old John Tower Photo 3985  

 

Figure 36: MLE14010 War memorial Photo 3987 
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Figure 37: MLE18593 pheasantry Photo 3840 Looking NW 

 

 
Figure 38: MLE18594 fishpond Photo 3863 Looking N 
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Figure 39: MLE18596 avenue of trees Photo 3870 Looking N 

 

 
Figure 40: MLE18597 stables Photo 3845 Looking SE 
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Figure 41: MLE18598 dog kennels Photo 3842 Looking NE 

 

 
Figure 42: MLE18599 gatehouse Photo 3897 Looking SE 
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Figure 43: MLE18600 gardens Photo 3860 Looking NW 

 

 
Figure 44: MLE18601 watermeadow Photo 3910 Looking SE 

 



 

ULAS Report No.2014-076 Accession No X.A63.2014  59 

 
Figure 45: MLE18602 deer barn  Photo 3972 Looking SE 

 

 
Figure 46: MLE18603 leat (adjacent to river) Photo 3830 Looking E 
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Figure 47: MLE18603 leat  Photo 3831 Looking NE 

 

 
Figure 48: MLE18603 leat  Photo 3833 Looking E 

 

 

 



 

ULAS Report No.2014-076 Accession No X.A63.2014  61 

Newly identified features 

 
Figure 49: FL00006 enclosure Photo 3867 Looking S 

 
Figure 50: FL00009 small moated site Photo 3908 Looking W 
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Figure 51: FL00016 ditched enclosure Photo 3916 Looking SE 

 
Figure 52: FL00018 enclosure Photo 4171  Looking N 



 

ULAS Report No.2014-076 Accession No X.A63.2014  63 

 
Figure 53: FL00019 moat/building  Photo 4165 Looking NW 

 
Figure 54: FL00055 ditch Photo 3874 Looking S 
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Figure 55: FL00446/7 enclosure Photo 4021 Looking E 

 
Figure 56: FL00451 square enclosure  Photo 4037 Looking NE 
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Figure 57: FL00452 bank/terrace Photo 4035 Looking S 

 
Figure 58: FL00454 pits Photo 3968 Looking NW 
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Figure 59: FL00483 ditch  Photo 4176 Looking E 

 
Figure 60: FL00490 bank Photo 4141 Looking SW 
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Figure 61: FL00534 bank  Photo 4078 Looking W 

 
Figure 62: FL00553 bank  Photo 4147 Looking NE 
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Figure 63: FL00554 bank/stones Photo 4157 Looking S 

 
Figure 64: FL00562 bank Photo 4113 Looking N 
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Figure 65: FL00593ditches Photo 4002 Looking W 

 
Figure 66: FL00612 pale Photo 3880 Looking W 
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Figure 67: FL00619 bank Photo 4070 Looking SW 

 
Figure 68: FL00635 enclosure Photo 3950 Looking NW 
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Figure 69: FL00639 pale  Photo 3966 Looking W 

 
Figure 70: FL00647 ditch  Photo 3935 Looking W 
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Figure 71: FL00655 banks Photo 4025 Looking W 

 
Figure 72: W005 sunken feature/saw pit? Photo 3890 Looking S 
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Figure 73: W007 bank/ditch Photo 3942 Looking E 

 
Figure 74: W009 stables Photo 3980 Looking N 
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Appendix 2: Gazetteer of sites 

 

The Gazetteer has been compiled in a relational database and exported into this document in PDF format. 

Designated, Un-designated and records of newly identified features are all listed in numerical order, in the 

order of Scheduled Monuments, Listed Buildings, Historic Environment Records, Features identified 

through LiDAR analysis and from walkover survey. 

 

Broad descriptions, classifications and period information are included in the top of each page. Individual 

observations and interpretations are listed below along with initials. Hence observations from the walkover 

survey are by Andrew Hyam and are initialled ‘AH’, interpretations offered by R.F. Hartley and A. Squires 

in a forthcoming publication on the Park have been incorporated and are initialled ‘RFH & AS’ and 

observations by Matthew Beamish are initialled ‘MGB’. 
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